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Activity Instructions

Activity Instructions

Overview

In this segment, you are expected to create all the related HTML pages for the usage
inquiry module of the customer service online suite of applications. You will create the
HTML pages according to the given specs, verify that it meets the requirements and
debug the application accordingly.

This activity is designed to introduce you to the IntelliJ IDEA integrated development
environment for application development, basic HTML and cascading style sheets, along
with processes and standards for development and testing.

Activity Steps
Prepare the Create HTML Debug and Save Project
Prepare ! : ; Reflect
Environment Pages Fix Files

To complete the activity you need to follow the steps above. These steps are explained
later in greater detail in this section of the binder.

Key Learning Points

At the end of the segment, you need to learn and understand:
e How to build Web pages using HTML

e What technical specifications contain, and the importance of using technical
specifications to code Web pages

¢ Using the IntelliJ toolset for application development
e What version control is, and how to use it in IntelliJ
e The basics of GUI development

Learning Materials

The following information may be found within this binder, the Reference Guide or the
Performance Support Tool. You do not need to thoroughly understand everything in
these resources at this time. Familiarize yourself with what the resources contain and
how they will be used. This section describes the purpose and location of each
document.

Input

Applications Developer’s Intro School Specifications Binder — Segment 1
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Activity Instructions

What

Why

Where

Activity Instructions

Guides you through the process of completing
the activity

Activity Instructions section in this
binder

Technical
Specifications

Used as a blueprint for the GUI design and page
logic

Technical Specifications section in this
binder

Reference Material

What

Why

Where

GUI Best Practices

Provides information on the common elements of
a user-interface

GUI Best Practices in the Performance
Support Tool

Getting Started with
intelliJ IDEA

Provides basic background and "how to"
information to get started using intelliJ

Intellid Help

Prepare the Environment Activity Steps
in this Binder

HTML & CSS Syntax

Provides HTML and CSS syntax and examples

Reference Guide

Frequently Asked Provides answers to questions found throughout | Frequently Asked Questions in the
Questions the Activity Instructions Performance Support Tool
Outputs
What Why Where
Input Page Enable CSR to input account number of Your desktop
subscriber
Subscriber Info Page | Provide subscriber information for verification Your desktop
Usage Page Provide usage information for a customer service | Your desktop
Monthly Usage Page | call
Error Page Provides the CSR with feedback if the Your desktop

No Account Page
No Usage Page

information he/she requests cannot be found

Step 1 - Prepare for this Activity

1. Review the information contained in each tab of the Activity Binder.

Briefly review the Activity Overview. Browse the sections of the design specifications. Get an
overview of the information they contain. You will use these sections extensively when you
are coding and debugging so it is helpful to gain a general understanding of these materials.

2. Mark your Reference Guide and Performance Support Tool.

Throughout this binder you will encounter questions inside text boxes. These are relevant to

Applications Developer’s Intro School
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the tasks at hand. You will find the answers to these questions from the either the Reference
Guide or Performance Support Tool provided to you.

Activity Instructions

3. Confirm your understanding of the application logic.

To confirm your understanding of the application logic, try to answer the questions below:

What page is displayed after the user clicks on the submit button from the input form
page?

Subscriber usage is derived from which table/s? What about subscriber monthly
usage?

What external file is used by all the HTML pages? Why?

Step 2 - Prepare the Environment

= What is a development environment and how do I learn to use it?

NOTE: It is important that the installation steps be done in the correct sequence.

1. Install the Java Development Kit (JDK)
2. Modify Environment Variables for use by Tomcat.

Applications Developer’s Intro School
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a. Right click on “My Computer” and select “Properties

r o )
é Adobe Photoshap ©5 (g it lusie
:I- My Computer
ﬁ Mero Burning ROM
g COpen
Explore
| Microsoft Office Excel 2003 canrchis
E’ Manage
3 Hetepad @ Map Metwork, Drive..,
Disconnect Metwork Drive. ..
W ricrosoft Office Word 2003 ‘ﬁ,
| w Show on Deskkop
o |
% L‘@ Rename
ti Adobe ImageReady 5

&ll Programs D

@| Lag OFF |§| Shut Down

& 2 WwindowsE... = | %32 Firefox

Applications Developer’s Intro School Specifications Binder — Segment 1
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b. Go to “Advanced” and change “Environment Variables”

Activity Instructions

System Properties

_ Sysztem Hgstnre f Automatic Updates

General | Camputer Mame |  Hardware

Y'ou mugt be logoed on az an Administrator bo make mogt of these changes.

Perfarmance

Vizual effects, proceszor scheduling, memony usage, and wirtual memony

Settings

Izer Profiles

Desktop zettingz related to vour logon
Settings

Startup and Recaover

System startup, svstem failure, and debugging information

Settings

[ E nvironment Y aniables ] [ Error Reporting ]

[ OF. l [ Cancel ] b oply

Applications Developer’s Intro School Specifications Binder — Segment 1
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Activity Instructions

Environment Variables

Iser wariables For RLR.amos
‘tariable Yalue
classpath C:1Program Files)Javatjdkl .6.0_01%ib
DEFALLT_CA_NR.  CAlLS
TEMP C:\Documents and SettingsirlramosiLoc. ..
TP CDacurents and Sektingsivlramosiloc, ..
| mew || Edt || Deete |
Syskem variables
Yariable Yalue ~
ComSpe: CHWIRDOWS system 32 crmd, exe
DEFALLT A MR CAS B
FP_MO_HOST C... MO
MUMBER_OF P... 1
05 Windows_NT »
mew || Edt || Delete |
[ (04 l [ Cancel ]
Add the following USER VARIABLES:

Mew Liser Yariable

Yariable name:

Yariable walue:

| CLASSPATH] |

| i \Program Files\Javatjdkl.e.0_014ib |

[ Ok H Cancel ]

where CLASSPATH is where your JDK’s lib folder is found

Applications Developer's Intro School
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Activity Instructions

Mew Liser Yariable

Variable name: | JaWA_HOME |

Yariable walue: | i \Program FilestJawaljdkl 6.0_01 |

[ Ok H Cancel ]

where JAVA_HOME is your JDK install directory

Modify the SYSTEM VARIABLE PATH by adding your JDK install directory’s bin

folder
Edit System Variable
Yariable name: | Path |
Yariable walue: | 0= W Program Files)Javaljdkl. 6.0 01'bin |

[ Ok H Cancel ]

NOTE: Be careful editing this value. You only add it at the end of the whole
PATH value.

Step Two — Install Apache Tomcat. Just use the default values.
Step Three — Install Winrar. You will use this to extract Eclipse.
Step Four — Extract Eclipse to a location where you can easily find it.
Step Five — Database Set-up

1. Copy the Access Database ADIS.mdb to your computer.
2. Go to Control Panel > Administrative Tools > Data Sources (ODBC) - System DSN

Applications Developer’s Intro School Specifications Binder — Segment 1
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Activity Instructions

"1 ODBC Data Source Administrator

UgerDSH  System DSM l File DSN] Drivers] Tracing] Connection F'l:u:uling] About ]

System 0 ata Sources:

M ame | Dirivver | Add...

il

An ODBC Syztem data zource stores infarmation abaut haw ta connect ta
the indicated data provider. & System data source iz wizible to all uzers
an thiz machine, including MT services.

k. Cancel Help

3. Click on ADD and select the Microsoft Access Driver. Then click on Finish.

Applications Developer’s Intro School Specifications Binder — Segment 1
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Create New Data Source El

Select a driver far which pou want to zet up a data zource.

M arre | WA
Drriver do Microzoft dBaze [°.dhbf]
Drriver do kMicrozoft Excel™ «lz]
Diriver do Microsoft Paradox [*.db

Diriver para o Microsaft Wisual FoxPro

kicrozoft Aco Mriver [*.mdb]
Microzoft Accesz-Treiber [ mdb]
Microsoft dB ase Driver [*.dbif]
Microzoft dB ase WFP Dnver [*.dbf]

v:-b-—‘-l‘-‘--l‘-‘-l‘-‘-—l-l‘-‘--l‘-‘-b-

| Finizh | Cancel

4. You will get the ODBC Set-Up window. Name the data source “adis”.
Browse for your adis.mdb file by clicking on “Select”.

ODBC Microsoft Access Setup

Select... | Create... | Repair... Compact... |

System D atabaze

Data Source Mame: |a|:|is k.
Description: |
Cancel
D atabaze
[ atabasze: Help

Advanced...

+ Mone
" Databaze:
Optiong: >
Applications Developer’s Intro School Specifications Binder — Segment 1
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Activity Instructions

After clicking “Select” look for your MDB file:
Select Database E|

D atabaze Mame

|adis.mdb

Lizt Filez of Type:

Directanes:
o

B oot

[C7 BIOSTools

[C7 Documents and Se
[ driverd«2300mt_sp—
1 java

[Z7 Frogram Files v

|

du

Dirives:

Aocess Databazes [“.mﬂ

|Ec:

[

OE.

Cancel

Help

[ Read Only
[ Exclusive

Metwark. ..

|

5. This is how your screen should look like once you've selected your database:

ODBC Microsoft Access Setup

Data Source Mame: |a|:|is

Description: |

D atabaze

Databasze: C:hadiz.mdb

Select... |

Create... |

Repair...

Compact... |

System D atabaze

(+ Mone

" Databasze:

I

ik

Advanced...

OF.

Cancel

Help

Optiong: >

Applications Developer's Intro School
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6. And this is how the ODBC screen looks like after everything has been done:

Activity Instructions

€1 DDBC Data Source Administrator

Usger D5k System DSM l File: DSN] Drivers] Tracing] Connection F'u:u:uling] About ]

System Data Sources:

M ame | Criver | Add
Microzoft Access Driver [*.mdb)

R emove

flif

Configure. .

An ODBEC System data source stores information abaut how to connect to
the indicated data prowider. & System data zource iz vizible to all uzers
an thiz maching, including MT zervices.

(] Cancel Help

Preparing the Web Project.

1. Open Eclipse.

Applications Developer’s Intro School Specifications Binder — Segment 1
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Activity Instructions

& J2EE - Eclipse SDK.
Fle Edt Navigate Search Project Run Window Help

O H-0-Q-i@E  Ziwigig M@0 IHF
CIET=DTEEN, © &7 7O

[# & Myweb

@1 servers

(12 J5R-109 Web Services

o consoles to display at this time.

o* 0 items selected

Problems | Tasks | Properties | Servers | Database Explorer | Srippets | Bl Console 52

EJ

[ [ 72 22gE | &) 2ave
= 082 ouine 52 =0

An outline is nok available,

2. Create a new Dynamic Web Project
& New Project
Select a wizard

Create a Dynamic Web project

Wizards:

X)

p—

| type filker text

‘:ﬁ Plug-in Project

= General

= s

== Eclipse Madeling Framewark
= EJB

(= J2EE

= Java

[ Plug-in Developrment

LR O = R e R e

57 Static Web Project
== Examples

>

4

@ < Back Finish

Cancel

Applications Developer's Intro School
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3. Fillin the name of the project.

& New Dynamic Web Project [g|

Dynamic Web Project
Create & standalone Dwnamic Web project or add it ko a new or existing Enterprise Application, | G

Project name: | myieb |

Project contents:
Use default

| 1 Lwar = | Browse..,

Targek Runtime

|<N0ne> v| [New...]

Configurations

| <cuskam = 4 |

Hint: et started quickly by selecting one of the pre-defined project configurations,

EAR Member ship
[ add project to an EAR.

Mew, ..

@ [ < Back ][ Mext = H Finish l[ Cancel ]

4. Set-up the Target Runtime. This will be the webserver your project will use. Click on the
“New” button to set this up.

Applications Developer’s Intro School Specifications Binder — Segment 1
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& New Server Runtime @

New Server Runtime
Defing a new installed server runtime environment

Runtimes are used at build time to compile projects.

Select the bype of runkime that you want to define:
Don't see your server listed? Click here
== Apache ~
E Apache Tomcat v3,2
E Apache Tomcat v4,0
E Apache Tomcat w41

Apache Tomcat +5.0
e &pache Tomeat w55
(= BEA Systems =

P —

Description: Apache Tomcat +S,0 supports 12EE 1.2, 1.3, and 1.4 Web modules,

®

Make sure you select the correct version of Tomcat for this step. Click on “Next”.

& New Server, Runtime E

Tomcat Server
[ 1y, Tomcat requires a Java SDK in order bo compile J5P files, Ensure

that the JRE preference settings point to an SDK install lacation.

Iame;

| Apache Tomcat vS.0 |

Tomcat installation directory:

| C:\Pragram Files\Apache Software Foundation Tomeat 5.0 | [ Browse... ]
JRE:
|W0rkbench default JRE b4 | [Installed JREs... ]

@ [ Finish ] [ Cancel ]

Browse to the main folder of your Tomcat installation and click on “Finish”.

Applications Developer’s Intro School Specifications Binder — Segment 1
Last printed 12/15/2008 11:18 AM 16



SMART
Sty Onezsng!

& New Dynamic Web Project @

Dynamic Web Project

Activity Instructions

>

Create a standalone Dynamic Web project or add it ko a new or existing Enterprise Application. ‘ G

Project name: | | |

Project contents:
Use default

Target Runtime

|Apache Tamcat 5.0 - |
Configurations
| <custam > 4 |

Hint: Get started quickly by selecting one of the pre-defined project configurations.

EAR Membership

2 < Back H Mext = ” Finish H Cancel

5. Click on Finish. You mii ht iet the screen below. Click on “Agree”.
License Agreement E|

A request has been made ko cache the resource:
hktp: fijava, sun. comxmlinsfji2eeiweb-app_2_4.xsd

In order ko cache the resource you must agree ko the license below:

3

Copyright 1994-2006 Sun Microsystems, Inc. All Rights Feserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

+ Redistribution of source code must retain the above copvright
notice, this list of conditions and the following disclaimer.

+ Redistribution in binarv form must reproduce the above copvright
notice, this list of conditions and the following disclaimer in the
documentation and’or other materials provided with the distribution.

INeither the name of Sun Microsystems, Inc. or the names of contributors
mav be used to endorse or promote products derived from this software
without specific prior written permission.

This software is provided "AS IS." without a warranty of any kind. ALL
EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS

AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY

OF MERCHANTABILITY, FITNESS FOR A PARTICULAR v

Applications Developer’s Intro School Specifications Binder — Segment 1
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Activity Instructions

6. Eclipse will process your request.

& New Dynamic Web Project

Dynamic Web Project

Create a standalone Dynamic Web project or add it ko a new or existing Enterprise application.

Praject contents:

Target Runtime

Configurations

EAR Membership

=k ko an EAR

Mew, .

& Open Associated Perspective?

\-/ open this perspective now?

[] remember my decision

This kind of project is associated with the J2EE perspective. Do wou wank to

Yes

8. You are now done with the initial steps.

Step 3 - Paint and Code the HTML Pages

Applications Developer's Intro School
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During this step you will build the basic structure of the HTML pages, and create the
page’s controls (that is, text boxes, labels, etc.). To perform this step, refer to the Page
Layout and Page Attributes of the Technical Specifications section.

You may code the following HTML pages in any order and save them in the web
resources folder - ¢c: \appdevschool\data\web

input_form.html
subscriber_info.html
subscriber_usage.html
subscriber_monthly_usage.html
sub_info_no_data.html
sub_usage_no_data.html
error.html

For every HTML file that you create, do the following steps:

1. In the open Intellid web project, right-click on the web folder and choose New-
File from the shortcut menu.

e
ot el LIy
2 copy Ctl+C 3] Isp
Zopy Path Zkrl4shift+C
2| Paste Chrl+Y
Find in Path. .. ChrH-Shift+F
Replace in Path, .. CEr-Shift+R.
Analyze b
Refactar b
Refarmat Code... ChrlAl+L
Delete. . Delete
o Walidate all J5Ps in directory 'web'
Make Module 'web'
Local Histary b
Applications Developer’s Intro School Specifications Binder — Segment 1
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2. Type the specified filename including the filename extension (e.g. error.html) and
click OK.
Blvenrie x
"_:] Enter a new file name:
| |
| oK | | Cancel |

3. Type the HTML tags as you would in a word processor.
4. From the File menu, select Save All to save your work.

= What is HTML?

= Where do I get help on HTML syntax?
= Why am I using a form tag?

= How is an HTML page structured?

= How do I link files to my page?

Step 4 - Debug and Fix

Since HTML is a markup language that is interpreted rather than compiled, the simplest
way to debug it is to open the files and see whether it looks like the way you intended it
to be.

1. Open Windows Explorer and navigate to the folder where you have saved your
HTML files are stored: c: \appdevschool\data\web

2. Double-click on the files to open them. It will be opened in the default browser
(i.e. Internet Explorer).

Note: Project standards will dictate which browsers will be used to check your HTML. For this
training, we will limit our testing to IE.

3. Compare your coded page to the Page Layout and Page Description sections of
this manual.

4. Edit your code in IntelliJ and save it.
5. Refresh the browser to reflect the changes you have made.

However, IntelliJ has helpful features that will help you easily detect syntax errors in your
HTML files while you are still typing them. This is why some programmers prefer to work
with an IDE rather than code their HTML in notepad. Some features you may find useful

are:

e Color-coded text — enables you to differentiate the different page elements such
as:

o dark blue = tags

Applications Developer’s Intro School Specifications Binder — Segment 1
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Activity Instructions

light blue = attributes

green = attribute values

gray = comments, and

black = text that will be displayed as is

O O O O

e Gutter symbols — after you finish typing your ending tag or when your cursor is
placed next to an ending tag, a blue bracket will appear on the gutter to indicate
which start tag it is closing.

<a href="http: f fwmnar. smart . com. phf" >
<img alt="Smart" src="imagessflogo.jpg" bhorder=0-</a>

¢ Highlights — special characters not coded as character entities or enclosed in
quotes are highlighted.

|<11n.k href="ztylesheets/=mart.c=s" type=text /c=s rel="stylesheet">|

Step 5 - Save Project Files

= How do I check in files?
= How do I add files into CVS?

After you have completed the coding and debugging of your HTML files locally, you must
upload the final documents to CVS.

1. Configure your project to connect to CVS.
a. Click on File — Settings. The Project Settings dialog box appears.
b. Click on Version Control from the Project tab.
c. Choose CVS from the Version control drop-down list box.

Applications Developer’s Intro School Specifications Binder — Segment 1
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Activity Instructions

E]Project Settings [web] - ¥ersion Control

Project IDE

%;"jﬁ} Paths
et

o

Compiler

. Praject
EEH" Code Style

l%) GUL Designer
s

‘ersion control: |C\-'S - |

—Cormmand Dialags

Display options dialog when these commands are invoked:

[¥] Add [¥] Edit [¥] Update

m [v] Remove [v] Checkout [w] Commit

~Updating

When project or module file is merged with conflicks:

@) Show dialog

{3 Skip merging For all project or module files merged with conflicks

{1 taet latest repository versions silenthe

~Files Creation/Delation

‘When files are created with IDEA: When files are deleted with IDE&:

@) Show options befare adding ko CYS
) Add ko CYS silently
() Do not add ko CYS

() Show options before remaoving From CVS
() Remnove from CYS silently
() Do not remove From CVS

~Cther Settings

] Show CYS server output
Cormrmit cormmentk:

[¥] Reuse last comment
[] Put Facus inta comment

[] Force non-emply comment

[C] Use read-only flag for not edited files  Default keyword substitution For text files | expansion -

Global Settings...

Default Yiew

I OF || Cancel || Apply || Help

d. Leave the default settings as is and click OK.

e. Click on File - Browse CVS Repository. The Select CVS Root

Configuration dialog box appears.
f. Click Configure. The CVS Roots dialog box appears.

Applications Developer's Intro School
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Activity Instructions

Bl]cvs Roots
E e

% ipserverimodel@10,121,54, 250! fhome frmodelf

x|

Cus roaky |aer:model@1u.121.54.250:,fhome;model,fRooTJnILxmyrepos| | Edit by Field. . |

~Use Yersion

(@) HEAD revision
) By kag (-r)

(1 By date (-D}

Password file: |$userdir,|'.cvspass

Connection timeout:

seconds

Proxy Settings
[] Use prosy
(@1 HTTP i Socks4

() Sockss

Login; |m0del

| Password: |********

Proxy host: |

| Proxy pork:

Test Connection

Global Settings. ..

| oK || Cancel || Help |

g. Inthe Cvs root text box, type :pserver:<username
@10.121.54.250:/home/model /ROOTJAIL/myrepos.

h. Inthe Login and Password text boxes, type the username and password
given to you by your instructor respectively.

i. Click OK to return to Select CVS Root Configuration dialog box.
j.  Click OK to connect to the root.
2. Import the project files to the CVS repository. You will only do this once.

a. Click on File — Import into CVS. The Import into CVS dialog box
appears.

Applications Developer's Intro School
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Activity Instructions

Import into CY¥5 E x|
Select C¥S Configuration
\pserverimodel@10,121.54.250: /home/model/ROOTIAIL/myrepos | Canfigure. ..
| < Previous | | Mext > | | Firish | | Cancel | | Help |

b. The CVS root you configured is selected by default. Click Next >.
Choose your username in the list and click Next >.

In the Select Import Directory list box, navigate to
c:\appdevschool\data and click Next >.

x

Select Import Directory

() @i%} :x.ilfg‘_.:‘ia:'J ]

Bl a
B Brch
=] - appdevschool
classes
Hata! =
| < Previous | | Mext = | | Finish | | Cancel | | Help |

e. You are then asked to Customize Keyword Substitutions. Leave this
as is and click Next >.

x

Import Settings

Mame in repository: |data |

Yendar: |Smart |
Release tag: |R1 |
Log message: | |i|

[¥] Checkout after impart  [C] Make checked out files read-anly

| < Previous | | Mesk = | | Finish | | Cancel | | Help |

f.  Type your name in the Vendor text box.
g. Make sure that the Checkout after import checkbox is checked.
h. Click Finish.

Applications Developer’s Intro School Specifications Binder — Segment 1
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3. After you import your files into CVS, concurrent access and modifications to it will
now be handled by the CVS application. For any changes that you make, update
your saved files in the repository.

a. Click on CVS - Commit Project.

Step 6 - Reflect on Key Learning Points
Inform your instructor that you have completed the coding and testing activities of this
segment. He/she will review your work.

Review the key learning points for this segment. Answer the following questions and
discuss them with your co-participants and faculty.

General
1. What did you learn from today's experience that will help you through the rest of
the course?
2. What would you do differently if you had to repeat today’s activity?

3. What did you learn from today's assignment that will help you orient yourself in
your next project?

4. How did your co-participants assist you in your learning? What are some of the
ways that you assisted them?

5. What kind of activity instructions or guidance can you expect on the job?
Specific

1. Name three things you learned today.
2. ldentify the method(s) you used to learn the coding syntax for HTML.
3. What strategy did you find most useful for identifying defects in your code?
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Technical Specifications

Purpose

This document details the processing logic for the HTML pages and their respective
controls. Sufficient information is provided to write the code for the pages. This technical
specifications document is a hybrid of sections derived from the full-length Functional
Specifications and DB Design Documents. In the future (depending on the scope of your
project), you may encounter full versions of these documents.

= What are functional specifications? Why do we need it?

Project Description

Users of the Smart Online facility for subscribers have been clamoring for an additional
feature that would enable them to look up their usage history to track their calls and
manage their subscription plan.

Management decided to pilot test this feature by adding the usage inquiry module to the
current suite of applications available to our customer service representatives.

It will be used in the following customer service interaction:

e The customer calls up the customer service hotline and gives his/her account
number to the CSR.

e The CSR inputs the account number into the system. If entry is successful, will
be shown the account information of the subscriber for verifying the caller’s
identity.

e Once the caller’s identity has been verified manually, the CSR can look up the
subscriber’s current month’s usage or the year-to-date usage history.

To aid us in defining the requirements, we are going to create mock up screens of the
system. This will allow the users to see the system before we actually do any codes.

Architectural Overview

The usage inquiry module that you will be developing is a web application. The diagram
below illustrates the system components involved in the proposed system architecture.
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Database Tables

Though the report pages display information from the database, database access is
abstracted from the report pages by several classes called managers. The managers
retrieve information from three tables in the database. The Table Definitions for these
tables are included below for informational purposes only.

SUBSCRIBER_INFO

SI_IMSI SI_NAME | SI_MSISDN | SI_IMSI | SI_ACC_NUM | SI_BIRTH | SI_MAIDEN
DAY _NAME
Primary varchar char char char varchar2 varchar
Key 30 20 20 20 14 20
TRANSACTIONS
TR_ID TR_IMSI TR_TS TR_UT TR_ID TR_COST
Primary Key char char char char decimal
20 14 20 10,2
MONTHLY_USAGES
MU_ACC_NUM | MU_TS | MU_ACC_ | MU_TS | MU_TRANS_| MU_COST
NUM NUM
Primary Key char char int decimal
20 6 10,2

Database Architecture

The tables used in the project are related to each other thus:
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MONTHLY USAGES SUBSCRIBER_INFO TRANSACTIONS

PK,FK1 |MU_ACC_NUM PK |55 PK |TR_ID

PK MU_TRANS DATE
MU_TRANS DATE —p S|_NAME < TRUIMSI
MU_TRANS_NUM SI_MISDN TR_TRANS_DATE
MU COST SI_ACC_NUM TR_USAGE_TYPE

- S|_BIRTHDAY TR COST
S|_MAIDEN_NAME k1 |1 st

Calling Sequence

All items except the presentation layer (items surrounded by box overlay) of the project
have been pre-coded. The diagram below illustrates how page request and response
are fulfilled within the web server.

Model View Controller
¥ (8 [ REED

D inpul fann himl
@ oo

subscriber usage jsp

y

S| Databasejav)

3

subscriber monthly usage jsp

[T

Ll

|

@sl SubscriberUsageManager java

@
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Systems Integration

The HTML pages use the following external files, functions and/or procedures to
accomplish the stated project requirements.

External File, Function

or Procedure Description or Purpose Type
smart.css Defines the formatting styles of Cascading Style
the elements of the company Sheet

website. also creates classes

that can be applied to elements
verify.js Validates data input for correct JavaScript function.
data type and format

Call Pattern References

Among the HTML files you will create today, the report pages are the only ones who will
display information from the database.

To enable you to incorporate data returned by the SQL calls, you will be asked to
convert these HTML pages into JSP pages in the following segment.

Page Description

input_form.html

The input form page contains a single text box where the user can enter a subscriber
account number. When the user clicks on a submit button, it should post the subscriber
account number to the subscriber information page or return an error if the account
number does not exist in the database.

subscriber_info.html

This page should display the following relevant subscriber information: subscriber name,
MSISDN, IMSI, account number, birthday and mother’s maiden name.

From this page the user can click on:

e change account button to return to the input form page and enter another
subscriber account.

e get subscriber usage button to show usage history year-to-date

Applications Developer’s Intro School Specifications Binder — Segment 1
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e get subscriber monthly usage button to show usage history for the current month
in a vertical table.

The page should follow a top-to-bottom-left-to right tab sequence. Images should not be
part of the tabbing sequence.

The Title bar should display “Subscriber Information”

subscriber_usage.himl

This page should show usage history year-to-date in a vertical table with the following
columns: IMSI, transaction date, usage type, transaction ID and cost.

From this page the user can click on:

e change account button to return to the input form page and enter another
subscriber account.

e get subscriber info button to display the subscriber information

e get subscriber monthly usage button to show usage history for the current month
in a vertical table.

The page should follow a top-to-bottom-left-to right tab sequence. Images should not be
part of the tabbing sequence.

The Title bar should display “Subscriber Usage”

subscriber_monthly_usage.html

This page shows usage history for the current month in a vertical table with the following
columns: account number, transaction date, number of transactions for the day, and
cost.

From this page the user can click on:

e change account button to return to the input form page and enter another
subscriber account.

e get subscriber info button to display the subscriber information
e get subscriber usage button to show usage history year-to-date

The page should follow a top-to-bottom-left-to right tab sequence. Images should not be
part of the tabbing sequence.

The Title bar should display “Subscriber Monthly Usage”
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sub_info_no_data.html
This page shows the following error message if subscriber information cannot be
retrieved from the database.

“The subscriber account number you entered does not exist or there was an error in
fulfilling your request.”

The Title bar should display “Subscriber Unknown”

There should be a link to the input form page so that they can re-enter the subscriber
account number.

sub_usage_no_data.html
This page shows the following error message if no usage records exists for a valid
account number:

“The subscriber account has no usage records or there was an error in fulfilling your
request.”

The Title bar should display “Subscriber Usage Unknown”

There should be a link to the input form page so that they can re-enter the subscriber
account number.

error.html
This page displays the following catch all error message for any other error encountered
by the controller:

“The resource you are looking for does not exist or there was an error in fulfilling your
request.”

The Title bar should display “Error”

There should be a link to the input form page so that they can re-enter the subscriber
account number.
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Page Layout

The HTML pages conform to the general layout below:

Smart Lago Simply Amazing Loge
{149 pixels x 49 pixels (142 pixelz x 49 pixels

Linebar {725 pixels x 21 pixels)

Drata Table

Copynght Nofice Site Links
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Data Entry Page: input_form.html

SMART Sy il

Subscriber Scoount Mumbet: submit |

Report Page: subscriber_info.himl

[Subscriber Name: information from the database will be passed here
[MSISDN: [information from the database will be passed here
[tmsI: imformation from the database will be passed here
[Account Number: linformation from the database will be passed here
[irthday: information from the database will be passed here
[Mother's Maiden Mame: information from the database will be passed here
Change Account | Get Subscriber Usage | Get Subscriber Monthly Usage

Report Page: subscriber_usage.himl

Transaction Date
< MMDDHHMMS S =

information from the
database will be passed
here

|IMSI Usage Type Trans. ID Cost

information from the
database will be
passed here

information from the
database will be
passed here

information from the
database will be
passed here

information from the
database will be
passed here

Input Farm | Get Subscriber Info | Get Subscriber Monthly Usage |

Report Page: subscriber_monthly_usage.html

[account Mum. [Transaction Date [# of Trans, [cost
information from the information from the information from the information from the
database will be passed database will be passed database will be passed database will be passed
here here here here
Input Form Get Subscriber Info | Get Subscriber Usage |
Applications Developer’s Intro School Specifications Binder — Segment 1
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Error Page: sub_info_no_data.html

SMART Sty sy

The subscriber account number you entered does not exist or there was an error in fulfilling your request.
Click here to try again

Error Page: sub_usage_no_data.html

SMART Sl tousi!

This subscriber account has no usage records or there was an error in fulfilling your request.
Click here to try again

Error Page: error.himl

H T Sinaly Aneziny!

The resource you are looking for does not exist or there was an error in fulfilling your request.
Click here to try again

Application Security Requirements

Although you are not required to implement any security controls in this particular
exercise, it is very important to note that you put input validation routines in your user
interfaces when building actual application systems.

Input validation is the first line of defense of our application system as it ensures that the
input data received by the system is valid and ‘safe’. ‘Safe’ means that the data inputs
are free from:
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Malformed characters, which could cause buffer overflows (e.g., excessive
number of characters), thus, could make the application crash which may
eventually result to “Denial of Service”.

Malicious entries such as SQL Commands in unfiltered form fields. Common
attacks nowadays includes SQL query strings entered through the form fields, by
which data manipulation can be done as if directly accessing the database. This
attack is also referred to as “SQL Injection”.

Invalid input characters and/or format for a certain data field, thus, allowing the
system to process unnecessary information.

The following are the best practices in designing data input validation as a security

control:
1.

2.

ok ow

System-wise, do not trust user inputs. ALWAYS VALIDATE user inputs as to
integrity, validity and accuracy.

Input validation and filtering should be done both at the client side and the
server side, especially for critical fields such as Username & Password.

Filter invalid inputs prior to actual processing.

Verify maximum character prior to processing, to prevent buffer overflow attacks.
Do not use unrestricted input fields that accept any data formats.
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